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Online Tutorial

Get a quick and easy introduction to Cookie Pal by using our online tutorial. This tutorial is available on
our web site. Click here to visit our web site and take the tutorial now.



Hints and Tips

The following hints and tips will help you to get more out of using Cookie Pal: 

· You can right-click on the cookie icon in your taskbar tray (next to the clock in the lower right corner 
of your screen) to see a menu of options.

· You can double click on the cookie icon in your taskbar tray to display the main window of Cookie 
Pal.

· You can select the "Check for Update" option on the cookie icon right-click menu to check if you have
the latest version of Cookie Pal.

· Did you know that the main window of Cookie Pal can be sized? Just move your mouse pointer to 
the edge of the window and drag the border out to make the window larger or smaller.

· "Temporary cookies" do not have an expiration date and are not stored on disk. They are stored in 
memory only and are removed from your computer when you close your web browser.

· You can accept all temporary cookies automatically by using an option on the Filters tab in the main 
window of Cookie Pal.

· You can click the "Detail" button on the Session tab in the main window to see the details of cookies 
that have been received in the current session.

· You can sort the lists on the Session and Filters tabs by clicking on any of the column heading 
buttons at the top of the list. A plus (+) or minus (-) symbol will be displayed to show whether the list 
is sorted forwards or backwards.

· You can select more than one cookie at a time in the Cookies list by holding down the CTRL key 
while clicking on cookies in the list. You can then delete them all at once by clicking the Delete button
to delete all highlighted cookies.

· You can select a range of cookies in the Cookies list by clicking on one cookie, and then holding 
down the SHIFT key while clicking on another. All cookies between the first and last cookies that you 
clicked on will be selected. You can then delete them all at once by clicking the Delete button to 
delete all highlighted cookies.

· Cookie Pal automatically works with Internet Explorer, Netscape and Opera even if they are all 
running at the same time.

· The browser options on the Cookies tab in main window change the browser whose cookies you 
currently see in the list above. It does no change which browser Cookie Pal works with because it 
works with all browsers automatically.

· You can select more than one filter at a time by holding down the CTRL or SHIFT keys while clicking 
on filters in the Filters tab. This lets you delete multiple filters at one time.

· You can add or remove programs that Cookie Pal monitors for cookies by going to the Configure tab 
in the main window and clicking on the Modules button.

· Cookie Pal can be configured to work with non-English language web browsers by clicking on the 
"Browser Settings" button on the Configure tab in Cookie Pal.

· Some anti-virus programs can slow down Cookie Pal when it is deleting cookies. If it takes a long 
time when you try to delete cookies, then try temporarily disabling your anti-virus program while you 
delete the cookies in Cookie Pal.

· You can click the Status button in the About window to see a list of the programs that Cookie Pal is 
currently monitoring for cookies.



What is Cookie Pal?
Cookie Pal is a complete Internet cookie management system for Windows 95, Windows 98, Windows 
ME, Windows NT 4.0 and Windows 2000. Cookie Pal works with your web browser to give you 
complete control over the cookies that are accepted by and stored on your system.

Cookie Pal works with the following web browsers and software:
· Microsoft Internet Explorer 3.x, 4.x and 5.x
· Netscape Navigator 3.x and 4.x
· Opera 4.x and 5.x
· Neoplanet
· CompuServe WinCIM 3.x and 4.x
· America Online 3.0, 4.0, 5.0 and 6.0 for Windows 95/98/ME
· Microsoft Outlook and Outlook Express
· Eudora E-mail
· Windows Media Player and RealPlayer

… and can be customized by the user to work with other 32 bit internet software which uses cookies.

Cookie Pal includes the following features:

· Automatically and transparently accepts or rejects cookies from all or specified servers without user
interaction.

· Cookies received from unspecified servers can be automatically accepted or rejected without user 
interaction, or the user can be asked for confirmation.

· Cookies can be accepted based on expiration date.
· "On the fly" adding of servers to the accept from and reject from lists, allows you to manually accept 

or reject a cookie the first time it is received and then have it automatically accepted or rejected every 
time it is received thereafter. 

· Wildcards allow cookies to be accepted or rejected from a group of servers on the same domain.
· Keeps a list of the number of cookies accepted and rejected from each server for the current session, 

as well as a detailed list of cookies accepted and rejected for the current session.
· Allows all cookies already on the system to be viewed and deleted.
· Can load and shut down automatically with your web browser. 
· Runs as an icon in the taskbar tray.
· Can be customized to work with other software which receives cookies and displays cookie alerts.
· Allows user selected sounds to be played when cookies are accepted and rejected, and when the 

confirmation window is displayed. Some sounds are included.
· Small application size, requires no extra runtime DLLs.
· Full 32 bit application, written in C++, uses minimal system resources.

Why use Cookie Pal?
Both Netscape Navigator and Microsoft Internet Explorer contain options to alert the user before a 
cookie is accepted. This causes the browser to pop up an alert every time a cookie is received and the 
user must respond to this alert before continuing. Some web pages can contain up to 20 or 30 cookies,
meaning a lot of annoying confirmations for the user. Cookie Pal intercepts these alerts that would 
normally be displayed and responds to them on your behalf before they are even displayed on screen -
your only clue that a cookie has been accepted or rejected will be a brief change in the task bar icon 
for Cookie Pal.



What's new?

Changes in version 1.6a of Cookie Pal
· Multiple filters can now be selected on the Filters tab in the main window of Cookie Pal.
· A new feature on the Filters tab allows third-party cookies to be automatically rejected when using 

the Advanced Security Update for Internet Explorer 5.5.
· Opera 4.0 and 5.0 are now fully supported within Cookie Pal.
· Support for Outlook, Outlook Express, Eudora, Media Player and other programs is now built in. 
· A new option on the "Configure" tab allows you to easily change the programs that Cookie Pal 

monitors for cookies.

Changes in version 1.5a of Cookie Pal
· Cookies that are not in the filter lists can now be accepted based on expiration date.
· Cookie Pal can now view and delete cookies from Opera 3.x (note however, that Cookie Pal cannot 

intercept cookies from Opera on the fly).
· The main window of Cookie Pal is now resizable.
· The expiration date of cookies is now displayed on the Cookies tab and in the Detail view on the 

Session tab.
· The cookie name is now displayed in the Detail view on the Session tab.
· When Internet Explorer cookies are deleted, the index entry is now deleted from the Temporary 

Internet Files folder as well as the cookie file on disk.

Changes in version 1.2d of Cookie Pal:
· Cookie Pal now fully supports Microsoft Internet Explorer 5.0 and default support is provided for the 

Neoplanet web browser.

Changes in version 1.2c of Cookie Pal:
· Cookie Pal now supports Netscape Communicator 4.5 and Microsoft Internet Explorer 5.0 Beta 2.
· The shift key can now be used to select a range of cookies on the Cookies tab in Cookie Pal.

Changes in version 1.2b of Cookie Pal:
· Cookie Pal now supports Microsoft Windows 98.
· A new button on the Session tab allows the session details to be cleared.

Changes in version 1.2a of Cookie Pal:
· Cookie Pal now provides support for the final release of Internet Explorer 4.0. Note that the preview 

releases of IE 4.0 are no longer supported.
· Cookie Pal now provides an option to allow the X button on the main window to just hide the window 

instead of exiting the application.

Changes in version 1.1b of Cookie Pal:
· Cookie Pal now provides support for Internet Explorer 4.0 Beta Release 2. Note that the initial 

preview release of IE 4.0 is no longer supported.

The following new features were introduced in version 1.1 of Cookie Pal:



· Cookie Pal can now be started and shut down automatically with your browser, or it can be started 
each time Windows is started. 

· Cookie Pal now has built in support for the Windows 95 version of America Online, Symantec Internet 
FastFind and Headliner.

· Cookie Pal can be easily customized to work with other 32 bit products which use Internet Explorer's 
or Netscape Navigator’s cookie mechanism.

· Wildcards allow filters to be set up to accept or reject cookies from all web sites in a given domain.
· The Session page now displays detailed cookie information for all cookies received during the 

session.
· Sounds can now be played when cookies are accepted and rejected, and when the confirmation 

window is displayed.



What is a cookie?
A cookie is a piece of data which is stored on your local computer by a web site that you have visited 
using your web browser. The data that is stored is then sent back to the web site every time you visit 
that site. The data can contain information such as a user name and password for that site, items you 
are purchasing on a shopping site, or any other information the web site desires.

Why should I be concerned about cookies?
There has been a lot of coverage in the press about cookies and potential privacy issues. The main 
issue is that web sites can keep track of your movements on their site by using cookies, so that they 
will know exactly where you have and have not been. They are increasingly used by companies and 
advertisers to monitor and accumulate internet user data. Many people feel that this is an invasion of 
privacy.

How does Cookie Pal help?
Cookie Pal helps by automatically responding to requests to store cookies on your computer. It is 
especially useful because you can set up lists of sites that you do and do not want to accept cookies 
from, and then Cookie Pal can respond automatically when a cookie is received from those specific 
sites. This allows you to accept cookies from certain sites (some shopping sites for example will not 
work correctly without cookies, or you may need to accept cookies from web addresses on your 
company LAN), rather than just rejecting all cookies which come your way, although this too can be 
done with Cookie Pal.



Browser options
Normally you will not need to change any browser options in order for Cookie Pal to work correctly. If 
you install Cookie Pal using its installation program then Cookie Pal will make all necessary 
adjustments for you so that it can run correctly.

However, there is an option which you must make sure stays enabled for Cookie Pal to work. Both 
Netscape Navigator and Microsoft Internet Explorer have options which cause an alert to be displayed 
before a cookie is accepted by the browser. This option must be enabled in order for Cookie Pal to 
work. When you install Cookie Pal it automatically enables these options and whenever Cookie Pal is 
started it also enables these options so you should never have to change them yourself, but if you do 
here is what to do:

Microsoft Internet Explorer 5.x
1. Select "Internet Options" from the Tools menu.
2. Click on the Security tab.
3. Click on each of the zones in turn.
4. For each zone, click on the Default Level to restore the default security settings for that zone. 

This will disable warning messages. To enable warning messages you should select Custom for 
each Security Zone and scroll down for the options for cookies. You can then select to display a 
message before accepting a cookie.

5. Click OK to close the dialog box and store the options.

Microsoft Internet Explorer 4.0
1. Select the "Options..." command from the View menu in Internet Explorer.
2. Click on the Advanced tab of the dialog box which appears.
3. Scroll down the list until you see the options for Cookies under the Security heading.
4. To enable warning messages ensure that the "Prompt before accepting cookies" option is 

selected. To disable warning messages select either the "Always accept cookies" option or the 
"Always reject cookies" option is selected.

5. Now look for the option titled "Browse in a new process".
6. Cookie Pal requires that this option be checked and may not work correctly without it. 

Specifically this option is needed in order for the auto-start feature of Cookie Pal to work.
7. Click OK to close the dialog box and store the options.

Microsoft Internet Explorer 3.x
1. Select the Options... command from the View menu in Internet Explorer.
2. Click on the Advanced tab of the dialog box which appears.
3. To enable warning messages ensure that the "Warn before accepting cookies" option is 

checked. To disable warning messages ensure that this option is not checked.
4. Click OK to close the dialog box and store the options.

Netscape Navigator 4.x
1.  Select "Preferences..." from the Edit menu.
2. Click on the word "Advanced" in the category list on the left side of the window.
3. To enable warning messages ensure that the "Warn me before accepting a cookie" on the right 

hand side of the dialog is selected. To disable warning messages, make sure that this option 



does not have a check mark in the box. To give Cookie Pal full control, you should also select 
the "Accept all cookies" option, and delete the permanent cookies that you do not want to be 
transmitted in Cookie Pal.

4. Click OK to close the dialog box and store the options.

Netscape Navigator 3.x
1. Select "Network Preferences..." from the Options menu.
2. Select the Protocols tab of the dialog which appears.
3. To enable warning messages ensure that the "Accepting cookies" option is checked. To disable 

warning messages ensure that this option is not checked.
4. Click OK to close the dialog box and store the options

Opera 4.x and 5.x
1. Select "Preferences..." from the File menu.
2. Click on the Privacy category in the list on the left hand side of the window.
3. To enable warning messages ensure that the two drop-down list boxes are set to "Display 

received cookies" and "Display third-party cookies" respectively. To disable warning messages, 
ensure that these are set to "Automatically accept all cookies" and "Accept from any servers".

4. Click OK to close the dialog box and store the options.



How does Cookie Pal work?
Cookie Pal works by intercepting the message box which would normally be displayed by your browser
to alert you of a cookie which has been received. Cookie Pal detects this message box before it is 
even displayed on screen, so if you are automatically handling cookies which are received then 
Cookie Pal will respond to this message box for you and it will disappear without you seeing anything 
on screen.

Because of the way Cookie Pal works it is very important that your browser is configured to 
display an alert when a cookie is received. Cookie Pal will enable this option for whichever browser 
you are using by default but if you need to change this option yourself for any reason, see the help 
topic title Browser options for information on how to do this.



Using the Cookie Pal taskbar tray icon 
When you run Cookie Pal, an icon is added to the taskbar tray (in the bottom right corner of the screen)
which can be used to interact with Cookie Pal. The taskbar icon minimizes Cookie Pal’s screen usage 
while running and can make its usage almost transparent.

The icon will appear as a small cookie in the taskbar tray and will appear different depending on the 
state of Cookie Pal as follows:

This icon appears when Cookie Pal is not monitoring any browsers.
This icon appears when Cookie Pal is monitoring cookies for a browser.
This icon appears briefly when Cookie Pal accepts or rejects a cookie.
This icon appears if Cookie Pal is disabled.

Displaying the main window
The main Cookie Pal window is not initially displayed when you start Cookie Pal. To display the main 
window you can either double click on the Cookie pal tray icon, or you can right click on the Cookie Pal
tray icon and select the Show command from the pop-up menu.

Hiding the main window
If the main window is currently displayed, you can click the minimize button in the main window to hide 
it. Alternatively you can double click on the Cookie Pal tray icon, or you can right click on the Cookie 
Pal tray icon and select the Hide command from the pop-up menu.

The tray icon menu
Clicking on the tray icon with the right mouse button will display a pop-up menu. This menu has the 
following commands on it:

Show/Hide This option will either show or hide the main Cookie Pal window. If the 
window is displayed, clicking the minimize button on the window will 
also hide it.

Add Browser This option allows you to customize Cookie Pal by having it monitor 
programs which are not recognized by Cookie Pal, that use cookies 
(and display cookie alerts). Click here to find out more about this.

Disable/Enable This option will either disable or enable Cookie Pal. This allows you to 
disable Cookie Pal's functionality without shutting it down. When 
disabled a different icon will appear in the taskbar tray and Cookie Pal 
will no longer intercept cookies from your browser. This means that you 
will see the default browser warning message whenever a cookie is 
received. Select the Enable command to activate Cookie Pal again.

WWW Home Page This option will display the Kookaburra Software web site in the default 
web browser on your computer.

Check for Update This option will connect to our web site and display a page showing 
whether any updates to Cookie Pal are available. If so, instructions will 
be provided on how to obtain the updates.

About This option will display the program copyright message, version number
and registered user information.

Exit This option will shut down Cookie Pal.





The main Cookie Pal window
The main Cookie Pal window can be displayed by either double clicking on the taskbar tray icon or by 
right clicking the tray icon and selecting the Show option from the pop-up menu. When the main 
window is displayed it can be hidden again by minimizing it, by double clicking on the taskbar tray icon 
again or by right clicking the tray icon and selecting the Hide option from the pop-up menu.

Closing the main window (using the X button in the top-right corner) will either completely shut down 
Cookie Pal or it will just hide the main window depending on the setting of the Exit when main window 
is closed option on the Configure tab.

The main window can be resized by moving the mouse cursor to any border of the window. When the 
mouse cursor changes to a double ended arow, click and drag the mouse to change the window size. 
The window size and position will be remembered for the next time that Cookie Pal is run.

The main Cookie Pal window contains several tabbed pages which display different information and let
you accomplish different maintenance tasks. You can click on the tab for each page to display that 
page. The following tabs are displayed:

Session This tab displays the web sites from which cookies have been received in the 
current session.

Filters This tab display a list of filters. Filters allow you to specify web sites from which 
you wish to accept and reject cookies. You can also specify what to do with 
cookies received from web sites for which you do not have a specific filter set 
up.

Cookies This tab displays a list of cookies which are already stored on your computer for
both Netscape Navigator and Internet Explorer. You can view the cookies and 
delete them if you wish.

Sounds This tab allows you to select custom sounds to be played when cookies are 
accepted and rejected by Cookie Pal, and when the confirmation window is 
displayed. You can also disable the standard sound played by your web 
browser when a cookie is received on this page.

Configure This tab allows you to configure Cookie Pal. You can define the text which 
Cookie Pal uses to recognize cookie alerts displayed by your browser. This is 
set up by default for English language versions of these browsers, but may be 
different for other languages. You can also set startup options for Cookie Pal 
here.

The main window also contains the following buttons along the bottom of the window:

Ordering… This button displays a help topic with information about how to order Cookie 
Pal.

Register… This button displays a dialog box which allows you to enter your registration 
information once you have registered your copy of Cookie Pal.

About… This button displays the program copyright message, version number and 
registered user information.

Help This button displays a help topic for the tab which is currently displayed    in the 
main window.



The Session page
The Session page can be displayed by selecting the Session tab in the main Cookie Pal window. This 
page displays a list of web sites (or servers) from which cookies have been received for the current 
session (i.e. since Cookie Pal has been started).

You can display summary information (the default) or more detailed information in this list by clicking on
the one of the Summary or Detail radio buttons below the list.

When displaying the summary list, the following columns are displayed:

Server This column displays the name of the servers or web sites which have 
attempted to set a cookie. The name is a web site domain name or IP address 
and will often begin with www.

# Accepted This column displays the number of cookies which have been accepted (either 
manually or automatically) from this server for the current session.

#Rejected This column displays the number of cookies which have been rejected (either 
manually or automatically) from this server for the current session.

Time This column displays the time at which the last cookie was received from this 
server. By sorting on this column you can easily see the most recent web sites 
which have attempted to set cookies on your computer.

When displaying the detailed list, the following columns are displayed:

<OK> This column displays either a check or an 'X'. A check is displayed if the cookie 
was accepted, and an X is displayed if the cookie was rejected.

Server This column displays the name of the servers or web sites which have 
attempted to set a cookie. The name is a web site domain name or IP address 
and will often begin with www.

Expires This column displays the date and time at which the cookie will (or would) 
expire. This is displayed in terms of the local time zone set on your computer.

Name This column displays the name of the cookie which the web site attempted to 
set.

Value This column displays the value of the cookie which the web site attempted to 
set.

Time This column displays the time at which this cookie was received from this 
server. By sorting on this column you can easily see the most recent cookies 
which web sites which have attempted to set on your computer.

Sorting the list
You can click on any of the buttons at the top of each column to sort the list by that column. Clicking on
the same button a second time will reverse the order that the items are listed in. A plus or minus sign (+
or -) will be displayed on the button for the column by which the list is sorted.    For example, you can 
click on the Server button to sort the list in order of server name. A plus sign will then appear after the 
word Server to indicate that the list is sorted in increasing order of server name. If you then click on the
Server button again, the list will be sorted in decreasing order by server name and a minus sign will be 
displayed after the word Server on the button.

Always Accept and Always Reject
These buttons will be enabled if you select one of the items in the list with the left mouse button. 



Pressing either of these buttons will add the name of this server to your Accept cookies from or Reject 
cookies from filter lists. If you do this, then cookies from this server will be automatically accepted or 
rejected in the future without user intervention (this only matters if you use the Ask for confirmation 
option on the Filters page).



The Filters page
The Filters page can be displayed by selecting the Filters tab in the main Cookie Pal window. This 
page displays two lists of web sites (or servers) from which cookies will be automatically accepted or 
rejected. In addition you can specify how cookies from servers which are not in these lists should be 
handled on this page.

The lists contain server or web site names in the form of their domain names or IP addresses. For 
example you could add www.microsoft.com to the reject list to always reject any cookies you receive 
from the Microsoft web site. Or you could add 200.100.100.1 to the accept list to always accept 
cookies from the web server at address 200.100.100.1 (which might be on the internet or your 
company LAN).

The easiest way to maintain these lists is by using the Ask for confirmation radio button which 
allows you to add server to these lists on the fly as cookies are received. See the Cookies from 
unknown servers topic below for more information.

Accept cookies from:
This list displays the servers from which you wish to always accept cookies. You can click on the New 
button below this list to add a new server to the list, or you can select a server from the list and click on
the Delete button below the list to delete a server from the list.

Reject cookies from:
This list displays the servers from which you wish to always reject cookies. You can click on the New 
button below this list to add a new server to the list, or you can select a server from the list and click on
the Delete button below the list to delete a server from the list.

Using wildcards in filters
You can use the wildcard character (*) in filters to accept or reject cookies from all web sites on a given
domain. The asterisk can be used at the start of a domain name or at the end of a numeric domain 
address. 

For example, specifying *.abc.com as a filter will match www1.abc.com, www2.abc.com,    xyz.abc.com
etc. When used with a domain name, the asterisk must be the first character and there must be only 
two parts of the domain name after the asterisk. i.e. *.abc.com can be used, but *.abc.def.com and 
abc.* cannot.

For numeric domains, the last part of the IP address can be specified as an asterisk. For example, 
200.200.200.* will match 200.200.200.1, 200.200.200.2, 200.200.200.255 etc.

If you use the Ask for confirmation option (described below) and you receive a cookie from a web site 
which has a 3 part domain name or a numeric domain, then a check box will appear on the 
confirmation dialog box. If you click the checkbox to place a check in it and then select the Never or 
Always button, then the domain name will be added to your filter list with a wildcard, and the filter will 
match all web sites on the same domain.

Reject third-party cookies
This feature only works if you have the Advanced Security Privacy update for Internet Explorer 5.5 
installed on your computer. 

Cookies that are received from a different web site than the one you are viewing are known as third-



party cookies. These cookies are usually set by advertising companies who may be displaying ads on 
the web site that you are visiting. Third-party cookies can usually safely be rejected and checking this 
option in Cookie Pal will cause third-party cookies to be rejected automatically.

Cookies from unknown servers
The radio buttons in this group allow you to specify what should be done when a cookie is received 
from a server which is not in either of the two lists above. You can choose from the following three 
options:

Reject all Selecting this option will cause Cookie Pal to automatically reject 
(without any user intervention) any cookies received which are not in 
the Accept cookies from: list. This allows you to set up a list of web 
sites from which you want to accept cookies and then reject any other 
cookies which are received.

Accept all Selecting this option will cause Cookie Pal to automatically accept 
(without any user intervention) any cookies received which are not in 
the Reject cookies from: list. This allows you to set up a list of web sites
from which you want to reject cookies and then accept any other 
cookies which are received.

Ask for confirmation Selecting this option will cause Cookie Pal to display a message box 
whenever a cookie is received which is not in either of the two lists 
above.    When such a cookie is received a dialog box will be displayed 
with four buttons allowing the user to choose what to do with the cookie.
The dialog will display information about the cookie and then will ask 
whether or not you want to accept the cookie. For more information 
about this message box see the help topic The cookie confirmation 
window.

Accept cookies that expire
This check box allows you to specify that any cookies that expire within a given time period 
should be accepted. If you select this option, then you can select the time period in the drop 
down list next to this option. With this option selected, a cookie that does not match any of the 
filters set up in the Accept and Reject lists (see start of this help topic) will be accepted if it 
expires within the specified time period (from the current time). If you select the "in the current 
browser session" option, then only cookies that will expire when the browser closes down will be
accepted. If the cookie does not fall within the specified time period, then it will be processed 
according to the options above.

Override Filters
If you check this option, then cookies that expire within the time period specified will be 
accepted even if the cookie is in your Reject cookies from: list. This allows you, for example, to 
accept all cookies that expire in the current browser session, even if the cookies would normally 
be rejected because they are in the Reject cookies from: filter list. Cookies that do not match the
expiration restriction here will still be treated as normal and accepted or rejected per other 
settings on this page.



The Cookies page
The Cookies page can be displayed by selecting the Cookies tab in the main Cookie Pal window. This 
page displays a list of cookies which are currently stored on your computer. The server (or web site) 
the cookie was received from, the cookie name and cookie value are displayed. You can use the radio 
buttons to display cookies stored by Netscape Navigator or by Internet Explorer. You can also delete 
any cookies that you want to.

The Cookies list displays the following columns:

Server This column displays the domain name of the server from which the cookie was 
received and which it will be sent back to. The server name is a web site 
domain name or IP address and will often begin with www.

Expires This column displays the date and time at which the cookie will expire. This date
and time is displayed in the local time zone of your computer.

Name This column displays the name of the cookie.
Value This column displays the value assigned to the cookie.

Sorting the list
You can click on any of the buttons at the top of each column to sort the list by that column. Clicking on
the same button a second time will reverse the order that the items are listed in. A plus or minus sign (+
or -) will be displayed on the button for the column by which the list is sorted.    For example, you can 
click on the Server button to sort the list in order of server name. A plus sign will then appear after the 
word Server to indicate that the list is sorted in increasing order of server name. If you then click on the
Server button again, the list will be sorted in decreasing order by server name and a minus sign will be 
displayed after the word Server on the button.

You can use the other controls in this page as follows:

Netscape
Selecting this radio button will display the cookies stored on your computer by Netscape Navigator in 
the cookies list.

Internet Explorer
Selecting this radio button will display the cookies stored on your computer by Microsoft Internet 
Explorer in the cookies list. Some Internet Explorer cookies may appear in gray. Click here for an 
explanation of cookies that appear grayed. 

Opera
Selecting this radio button will display the cookies stored on your computer by the Opera web browser 
in the cookies list. 

Delete
This button will delete the cookie which is currently selected in the list above. The cookie will be 
permanently deleted from your computer. 

If you find that the cookie does not get deleted, or that it keeps coming back then make sure that your
web browser is not running when you try to delete the cookie. Netscape and Opera both keep a 
copy of the cookie file in memory while they are running and write a new file to disk based on what they



currently have in memory at various times while they are running and when they are shut down. 
Therefore if you delete a cookie in Cookie Pal and then close down Netscape (or Opera), the cookie 
file will be overwritten and the cookie will reappear. As stated earlier, to make sure that cookies are 
correctly deleted, close down your web browser before deleting the cookies in Cookie Pal.

Refresh
This button will read the cookies again from disk and display the newly read cookies in the list above. 
Internet Explorer stores cookies as they are received, so if cookies have been received since you first 
displayed this list you can press the Refresh button to read the new cookies which have been stored. 
Netscape Navigator only stores the cookies permanently when it shuts down, rather than as they are 
received, so you will only see any new cookies after Navigator is shut down and you then click the 
Refresh button.

Cookies Path
This text line displays the folder on your computer in which Cookie Pal looks to find cookies. It will be 
different for each of the browsers that you can select using the radio buttons above.

Change
This button lets you change the folder that Cookie Pal looks in to find cookies for the currently selected 
web browser. You normally will not need to do this as Cookie Pal automatically detects where the 
cookies are stored on your system.

Reset
This button resets the Cookies Path (see above) to its default location. In the event that you have 
changed this using the Change button, you can get Cookie Pal to look in the default folder for cookies 
again just by clicking the Reset button.



The Sounds page
The Sounds page can be displayed by selecting the Sounds tab in the main Cookie Pal window. This 
page allows you to disable the standard alert sound which is played by your browser when a cookie is 
received, and it lets you define custom sounds to be played when cookies are accepted and rejected, 
and when the confirmation window is displayed.

Disable standard alert sound
If you have a sound card installed in your system you may want to select this option. Normally when 
Navigator or Internet Explorer display a cookie alert message you will hear a sound as the message box
is displayed. When Cookie Pal intercepts the message box it cannot prevent the sound from being 
played at that time. Selecting this option will cause Cookie Pal to permanently disable the sound while 
both Cookie Pal and a web browser are running . The side effect of this is that it will disable the sound 
for all similar message boxes displayed by any other applications in your system. The sound is only 
disabled while Cookie Pal and a browser are running if this option is checked. When you close your 
browser or Cookie Pal the sound setting will be restored in the registry.

Play this sound when a cookie is accepted
This option allows you to select a sound to be played whenever a cookie is accepted by Cookie Pal. 
The drop down list on the combo box shows sounds which are located in the current folder. You can 
choose any of these simply by selecting them with the mouse. The button with the ellipsis (3 dots) next 
to the combo box allows you to choose a WAV file to be played from another directory. If you do this 
then the drop down list will be changed to display any other WAV sound files from the same directory 
as the chosen file. Click the Test button to hear the sound. The top option in the drop down list will 
always be none - select this option if you do not want to hear any sound when a cookie is accepted.

Play this sound when a cookie is rejected
This option allows you to select a sound to be played whenever a cookie is rejected by Cookie Pal. 
See the description of Play this sound when a cookie is accepted above for information on how to 
choose this sound.

Play this sound when the "alert window" is displayed
This option allows you to select a sound to be played whenever Cookie Pal displays the confirmation 
window to ask you if you want to accept or reject a cookie. See the description of Play this sound when
a cookie is accepted above for information on how to choose this sound.



The Configure page
The Configure page can be displayed by selecting the Configure tab in the main Cookie Pal window. 
This page allows you to configure Cookie Pal in the following ways:

Configure Cookie Pal for use with non-English web browsers
You can click on the Browser Settings button to define the text which Cookie Pal uses to recognize 
cookie alerts displayed by your browser. This is set up by default for English language versions of 
these browsers, but may be different for other languages. 

Change the programs that Cookie Pal monitors for cookies
You can click on the Modules button to change the programs that Cookie Pal watches for cookies. By 
default Cookie Pal monitors the main web browsers and several other programs. If you want Cookie 
Pal to monitor an additional program, or if you want to prevent Cookie Pal from monitoring a program 
for cookies then you can make those changes here. Also see the Add Browser command to see 
another way to get Cookie Pal to monitor other programs for cookies.

Exit when main window is closed
If this option is checked (which is the default setting), then when you close the main window of Cookie 
Pal (using the X button in the title bar) it will completely close down Cookie Pal and remove the cookie 
icon from the taskbar tray.

If this option is cleared, then when you close the main window, it will act as if you had clicked the 
minimize button, and the main window will simply disappear without closing down Cookie Pal. To 
display the main window again, just click on the cookie icon in the taskbar tray with the right mouse 
button and select the Show command from the popup menu.

Monitor Explorer Windows
This option can be used if Cookie Pal does not start automatically when you start Internet Explorer. 
Some computers run Internet Explorer inside a regular Explorer window (instead of running it as a 
separate program), making it hard for Cookie Pal to detect when you have started your web browser. If 
you check this option, then Cookie Pal will be able to tell when Internet Explorer is running inside a 
regular Explorer window and will be able to start automatically (if you have the Start with browser 
option (see below) enabled).

Note: This option has the side effect that all Windows Explorer windows will be monitored by Cookie 
Pal. This means that if you just open an Explorer window to view files on your own computer, then 
Cookie Pal will run and will monitor those windows as well.

Startup options
You can select one of these options to determine how Cookie Pal starts up. One of the following 
options can be selected:

Start with Windows This option will add a shortcut for Cookie Pal to your Startup group on 
the Start menu. Every time Windows starts, Cookie Pal will 
automatically be loaded and you will see the cookie icon in the taskbar 
tray.



Start with browser This option will cause Cookie Pal to be loaded whenever you start your 
web browser or Internet software. When you shut down your web 
browser, Cookie Pal will also shut down. 

Start manually If you select this option, then you must start Cookie Pal yourself when 
you want it, by clicking on it's icon in the Start menu. You must also 
close Cookie Pal yourself when you do not want it running anymore.



The cookie confirmation window
If you use the Ask for confirmation option on the Filters page, then you will be asked for confirmation 
when a cookie is received from a web site that you do not have a filter for. That is, any web sites which 
are not in your Accept cookies from list or your Reject cookies from list, and which attempt to set a 
cookie will cause a message box to be displayed on screen asking whether you want to accept the 
cookie or not. If the web site is in one of your filter lists (accept or reject), then the cookie will 
automatically be accepted or rejected without interaction and you will not see this confirmation 
message.

The confirmation message is displayed in a window which has four buttons allowing the user to choose
what to do with the cookie. The window will display information about the cookie and then will ask 
whether or not you want to accept the cookie. You can answer using one of the following buttons in this
dialog box:

Yes Selecting Yes will accept the cookie just this one time. If the cookie is received 
again in the future you will be prompted again.

No Selecting No will reject the cookie just this one time. If the cookie is received again 
in the future you will be prompted again.

Always Selecting Always will accept the cookie and then add the name of the server from 
which the cookie was received to the Accept cookies from list. Whenever any 
cookies are received from this server in the future, they will be automatically 
accepted with no further user interaction. If you click the wildcard check box (above 
the Never and Always buttons) before selecting Always, then the filter will be added 
to the accept list with a wildcard (see below).

Never Selecting Never will reject the cookie and then add the name of the server from 
which the cookie was received to the Reject cookies from list. Whenever any 
cookies are received from this server in the future, they will be automatically 
rejected with no further user interaction. If you click the wildcard check box (above 
the Never and Always buttons) before selecting Never, then the filter will be added 
to the reject list with a wildcard (see below).

The wildcard checkbox
Sometimes a checkbox will be displayed in this window just above the Always and Never buttons. 
When this checkbox is displayed it will display the name of the server (from which the cookie was 
received) converted to a wildcard. If you click this checkbox to place a check in it, and then click the 
Always or Never buttons, then the wildcard will be added to the Accept from or Reject from filter list. 
For example if a cookie is received from www1.abc.com, then the checkbox will display the text 
*.abc.com. If you check this box and then hit the Always or Never button, then the filter *.abc.com will 
be added to your filter list. In the future cookies received from www1.abc.com, www2.abc.com or 
xyz.abc.com (any server ending in abc.com) will be accepted or rejected automatically.
Note that this checkbox will not always be displayed. If the server name cannot be converted to a 
wildcard (i.e. the server name has only 2 parts such as server.com, rather than www.server.com) then 
you will not see the checkbox displayed.
For more information on wildcards, see the topic 'Using wildcards in filters' on the Filters page.



Monitoring new programs for cookies using the Add Browser command
Sometimes Cookie Pal may not recognize a cookie alert which is displayed on screen. This is usually 
because the cookie alert is displayed by a program which Cookie Pal does not recognize. The 
programs which Cookie Pal knows about are :

· Microsoft Internet Explorer (3.0 or later)
· Netscape Navigator (3.x and 4.x)
· Opera 4.0 or later
· Compuserve WinCIM (3.01 or later)
· America Online (3.0 or later for Windows 95/98/ME)
· Microsoft Outlook and Outlook Express
· Eudora
· Windows Media Player
· Real Player
· Neoplanet

If you have other (32 bit) programs running which handle cookies and display either the Netscape or 
Internet Explorer standard cookie alert messages, then Cookie Pal will not intercept the cookie alert 
messages by default. But you can add these programs to Cookie Pal's list of programs to monitor
so that it will intercept cookies from these programs as well. You can see which programs Cookie Pal is
monitoring by using the Modules button on the Configure tab of Cookie Pal. Here's what to do to add a 
new program if you see the standard cookie alert message on your screen::

1. Make sure that Cookie Pal is running. You will see the little cookie icon in the taskbar tray (next to 
the clock in the lower right corner of the screen) when it is running.

2. Wait until you see one of the cookie messages on screen which Cookie Pal has not recognized.

3. While the cookie message is still displayed, click on the Cookie Pal icon in the taskbar tray with the
right mouse button. A popup menu will appear, and you will then need to select the "Add Browser" 
command.

4. Cookie Pal will attempt to find any cookie alerts which are on screen and will try to identify the 
program which displayed the alert. If the program which displayed the alert is a 16-bit program, 
then Cookie Pal will report that it cannot find any cookie alerts on the screen.

5. If Cookie Pal does recognize the alert, it will display a message saying that it has detected the 
program which displayed the alert, and will ask you if you would like to monitor this program in the 
future. Click Yes to add this program to the list of programs monitored by Cookie Pal.

6. You will then need to restart both Cookie Pal and the other program, before Cookie Pal will work 
correctly with it.

Once you follow these steps, Cookie Pal will monitor the program for cookies in the future. Note that 
this will not happen until you shut down both the program which displayed the cookie alert and Cookie 
Pal, and start them both again.

Please note that Cookie Pal cannot monitor any 16 bit programs for cookies, or any programs which do
not display a standard Internet Explorer or Netscape Navigator cookie alert message when they 



receive a cookie.



What is Registration?
Cookie Pal is a "Shareware" program. This means that you are free to use the software for up to 30 
days free of charge for evaluation purposes. If you decide to keep the software after 30 days then you 
must register your copy with Kookaburra Software for a small fee.

The shareware (or unregistered) version of Cookie Pal contains all of the functionality of the registered 
version. This allows you to make sure that it works satisfactorily for you before you purchase the 
software.

When you register Cookie Pal the welcome screen which is displayed when you start the program will 
be removed. In addition registration entitles you to free technical support and minor upgrades to the 
software. And don’t forget that registering this and other shareware programs allows the authors to 
continue development on those and new products.

Click here to find out how to register.



How to Purchase Cookie Pal

The price for a single copy license of Cookie Pal is US$15.

Please check the Kookaburra Software Web Site for the latest ordering and pricing information.

When you place an order you will receive by return e-mail or regular mail a product registration 
number. You must then enter your name and this registration number into your existing copy of Cookie 
Pal using the Registration dialog box, which is accessed by selecting the Register option from the 
Cookie Pal main window. You should keep your registration number safe, so that you can re-enter it 
if you need to re-install Windows or if you upgrade to a new computer at any time in the future.

 

Secure Online Ordering 
The easiest way to order Cookie Pal is to order online 
using the secure order form at our Web site. To do this, 
just go to our Web site at http://www.kburra.com and follow
the links for online ordering. Online orders are handled by 
DigiBuy. Once your order is verified you will immediately 
be sent a registration notice by e-mail which allows you to 
unlock your copy of Cookie Pal.

Ordering by check
To order by check enter your order information in our 
Interactive Order Form and send the printed order form 
and a check to Kookaburra Software. Instructions for 
ordering by check are included on the Interactive Order 
Form. Payment must be in US dollars drawn on a US 
bank, or you can send international postal money orders in
US dollars. Your registration information will be sent to you
via e-mail or post.
If you cannot access the order form using the above 
buttons, click here to view the form embedded in this help 
file.

European Customers
You can order through the ShareIt! Registration service 
based in Europe. Payment can be made in Euros or in US
Dollars. You can also pay using bank transfers, 
EuroCard, credit card or check. Click here to go to the 
ShareIt! Web site to order Cookie Pal.

Ordering by Phone or Fax
For information on ordering by phone or fax, click here. 
Your registration information will be sent to you via e-mail 
or post.

Site licenses
A site license for Cookie Pal entitles an organization to receive a single product registration number 



and use it to register Cookie Pal on the specified number of computers. Site license pricing is indicated
below. Note that site licenses cannot currently be purchased when ordering through Compuserve - you
must choose one of the other ordering methods. All prices listed are in US$.

 2 to      9 computers: $13 each
10 to 24 computers: $11 each
25 to 49 computers: $9 each

50 or more computers: $7 each



Ordering by Phone or Fax

Phone: DigiBuy's operators are available to take Cookie Pal orders
24 hours a day, 7 days a week at the following numbers: 

800-242-4775    (toll free)
952-253-8175 (Minnesota and overseas residents)

Please specify product number 15218 when ordering by phone. 
Please note that the phone operators cannot answer product 
questions and are only available for taking orders. 

FAX: You can place FAX orders by going to the online ordering 
section of our web site. Follow the normal online ordering 
instructions, and after entering your name and address details you 
will be able to select the option to FAX your order. You will then be 
presented with a printable form that you can use to complete your 
credit card information and send by FAX to DigiBuy.

Note that credit card orders are taken through DigiBuy, an independent company which 
provides a credit card ordering service only - if you have any questions regarding the 
status of your order after it has been placed with DigiBuy, please contact 
Kookaburra Software directly. The best way to contact us for order status information is
to send e-mail to orders@kburra.com . For any other inquiries regarding Cookie Pal 
please send e-mail to support@kburra.com 

When you contact DigiBuy they will require the following information:

Product Name: Cookie Pal
Product ID: 15218

Your Name: ______________________________________

Company: ______________________________________

Your E-Mail Address: ______________________________________

Credit Card [ ] MasterCard      [ ] VISA      [ ] AMEX      [ ] Discover

Credit Card Number: ______________________________________ 

Expiration Date: ______________________________________ 

Name On Card: ______________________________________ 

Billing Address: ______________________________________ 

______________________________________ 

Qty. Required: ________

Please ensure that the credit card number and expiration date are provided and are written 
clearly if ordering by fax.



                                                                                                                  
Any questions about the status of the shipment of the order, registration options, product details, 
technical support, volume discounts, dealer pricing, site licenses, non-credit card orders, etc, must be 
directed to Kookaburra Software, PMB 235, 10824 SE Oak St., Milwaukie, OR 97222-6694 or by 
internet e-mail to orders@kburra.com .

DigiBuy will notify us the day that they receive your order and we will send your registration number to 
you.



Cookie Pal Order Form
Try using the Interactive Order Form which lets you type in your order details and which will then print 
the completed order form for you. Only use the form on this page if you cannot access the order entry 
program.

This order form is for ordering by check or money order only.

To print this order form click the Print button above or select the Print Topic option on the File pull-down
menu.

These prices are guaranteed through August 2001. An up-to-date version of Cookie Pal can be 
obtained from the Kookaburra Software web-site at www.kburra.com . 

Send this order form
to:

Kookaburra Software
PMB 235
10824 SE Oak Street
Milwaukie, OR 97222-6694
U.S.A.

Please check our web site at 
http://www.kburra.com/order.html 
to ensure this address is still 
current 
before mailing orders.

Name: _______________________________________________

Company: _______________________________________________

Address: _______________________________________________

City: _______________________________________________

State/Province: _______________________________________________

Zip/Post Code: ____________________      Country: __________________

Phone: (daytime) _______________ (evening)________________

E-Mail Address: _______________________________________________

Order Information

Cookie Pal Single Copy License
I would like to register _____ copies of Cookie Pal at $15 each = _______

Cookie Pal Site License - For companies or organizations
2 to      9 computers: _____ computers at $13 each = _______
10 to 24 computers: _____ computers at $11 each = _______
25 to 49 computers: _____ computers at $9 each = _______

50 or more computers: _____ computers at $7 each = _______

Total payment enclosed: $ _______

Payment must be in US dollars drawn on a US bank, or you can send international postal money 
orders in US dollars. Make checks payable to Kookaburra Software.



How did you hear about Cookie Pal? ______________________________________

Comments:



How to enter your registration number

You can enter your registration number (obtained by registering your copy of Cookie Pal) using the 
Register dialog. 

You can enter your registration number in any of several ways:

· When you are installing Cookie Pal you will be prompted to enter your registration name and number if
you have it available at that time. If you have your registration number available you can enter it here, 
and Cookie Pal will be registered when it is installed.

OR

· When you start Cookie Pal you will see a blue Welcome screen with four buttons along the bottom of 
it. Press the button labeled Register… and you will be able to enter your registration name and 
number.

OR

· You can select the Register button from the main window of Cookie Pal, or you can click on the 
Cookie Pal taskbar tray icon (in the bottom right corner of your screen, next to the clock) with the right 
mouse button and select the "Register…" option from the pop-up menu.

In the Register dialog box you need to enter your name and number as follows:

Name
Enter your name as it appears on your registration notice from Kookaburra Software. You must enter 
you name exactly as it appears on this notice.

Registration Number
Enter your registration number exactly as it appears on your registration notice from Kookaburra 
Software.

Once you have entered your registration information correctly and selected OK, your copy of Cookie 
Pal will be registered. You must save your registration information (name and number) as you will 
need to re-enter it if you re-install Windows or if you upgrade to a new computer.



Support options

Kookaburra Software provides online technical support to users of Cookie Pal. Please click here to 
check the Support section on our web site at www.kburra.com for information on how to obtain 
technical support and to view solutions to common issues and problems.



Cookie Pal License Agreement

END-USER LICENSE AGREEMENT

The following is a legal software license agreement between you, the LICENSEE, and Kookaburra 
Software, setting forth how you can use Kookaburra Software's Cookie Pal computer software, 
documentation and other associated media ("THE SOFTWARE").    You acknowledge that you agree to 
its terms by downloading, installing, and/or using THE SOFTWARE.    Carefully read this license 
agreement before using the product.

Grant of License: This product is licensed as a SHAREWARE computer software program. This license
permits you to install one copy of the software included in this package on a single computer only. You 
may evaluate this product for a maximum of thirty (30) days from the time you first install it onto your 
computer. After this time you must either remove this software from your computer or purchase a license
for the software from Kookaburra Software. You are permitted to make one (1) back-up copy of the 
registered software for your personal protection.

Ownership: The software is owned by Kookaburra Software and is protected by United States 
copyright laws, international treaty provisions, and all other applicable national laws. No program, 
code, part, image, text or sound may be copied or used in any way by the user except as detailed in 
this license agreement.

Redistribution: You have permission to include and distribute the evaluation version of the software in
a commercial Shareware CDROM, download web site or other collection, together with other software. 
If you include it in any such package the following restrictions apply: (1) The distribution format is not to
be modified in any way from the original supplied by Kookaburra Software. Specifically no files may be 
altered, deleted or added to the distribution file(s); (2) The distribution must not include a registration 
number.    In particular, you may not distribute a registered or licensed piece of software. Only the 
evaluation version of the software may be redistributed; (3) No money can be charged to the person 
receiving the software, beyond reasonable cost of packaging and other overhead; (4) You must notify 
Kookaburra Software that you are redistributing the software.

WARRANTY DISCLAIMER:    ALL PROGRAMS ARE PROVIDED "AS IS" WITHOUT ANY 
WARRANTY OF ANY KIND, EITHER IMPLIED OR EXPRESSED, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE, FUNCTIONALITY, OR DATA INTEGRITY, OR PROTECTION.    THE ENTIRE RISK AS TO 
THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH THE USER.    SHOULD THE 
PROGRAM PROVE DEFECTIVE, YOU, AND NOT KOOKABURRA SOFTWARE ASSUME THE 
ENTIRE COST OF ANY NECESSARY REPAIRS OR CORRECTIONS.    KOOKABURRA SOFTWARE 
DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED WITHIN ANY OF ITS PROGRAMS 
WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF ANY OF ITS PROGRAMS 
WILL BE UNINTERRUPTED OR ERROR FREE.

LIMITATION OF LIABILITY:    IN NO EVENT WILL KOOKABURRA SOFTWARE BE LIABLE FOR ANY
DAMAGES, INCLUDING, BUT NOT LIMITED TO, LOST PROFITS, LOSS OF INFORMATION, 
BUSINESS INTERRUPTIONS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING FROM THE USE OR INABILITY TO USE THE SOFTWARE (WHETHER OR NOT DUE TO 
ANY DEFECTS THEREIN) EVEN IF KOOKABURRA SOFTWARE HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.    IN NO EVENT 
SHALL KOOKABURRA SOFTWARE’S LIABILITY EVER EXCEED THE PRICE PAID FOR THE 
LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF THE CLAIM.



Acknowledgment:    Your use of any software produced by Kookaburra Software is based only on 
your acknowledgement that you have read this Agreement, understand it, and agree to be bound by its
terms and conditions.    You further agree that it is the complete and exclusive statement of the 
Agreement between you and Kookaburra Software which supersedes all proposals or prior 
agreements, oral or written, and all other communications between you and Kookaburra Software 
relating to the subject matter of this Agreement.



Frequently Asked Questions

The items below address some questions which are commonly asked about Cookie Pal. 

The Kookaburra Software web site also has a list of Frequently Asked Questions which may be more 
current than this one. You can access this list using your web browser at http://www.kburra.com and 
then selecting the Support option.

· Cookie Pal does not seem to be working. What can I do?
· I still see the Internet Explorer "Security Alert" or Netscape cookie alert even though I have Cookie

Pal running.
· Cookie Pal does not recognize cookies from a program that I am running. 
· When I delete cookies, they keep coming back.
· Why is the Session page blank when I know I have received cookies? 
· Why don  ’  t cookies which I have received show up on the cookies page?   
· How do I configure Cookie Pal to work with my non-English version of Internet Explorer or 

Netscape Navigator? 
· What is the CPBRWTCH.EXE program? 
· When I run my web browser without Cookie Pal I now see annoying dialog boxes asking about 

Cookies.
· How do I turn off the sound that gets played when Cookie Pal encounters a cookie?



Cookie Pal does not seem to be working. What can I do?

Possibility 1

Cookie Pal relies on the warnings which your browser normally displays when a cookie is received. If your
browser does not display these warning messages then Cookie Pal cannot work. You can check to make 
sure that "Cookie Warnings" are enabled for your browser by following these instructions.

Possibility 2

If the cookie icon in the taskbar tray never changes to a smile, then it is likely that the browser you are 
using is not a standard version of Netscape Navigator or Internet Explorer, or that you have another 
program running which is displaying cookie messages (such as a stock ticker program, or some news 
ticker programs). Note that Cookie Pal will not work with 16 bit programs, so make sure that you are using
the 32 bit version of your web browser. See the topic below for more information. 

Possibility 3
If you are using a non-English language web browser, then you may need to configure Cookie Pal to 
work with the correct language. Please see the topic about configuring Cookie Pal for non-English 
language browsers for more information. 



I still see the standard Internet Explorer or Netscape cookie alert even though I 
have Cookie Pal running.

This is usually caused because the alert message you are seeing is being displayed by a program 
which Cookie Pal does not know about. For example, programs such as My Yahoo Newsticker, 
Napster, chat programs and more can all display cookie messages, and it may not be obvious that 
these cookies are coming from a different program than your web browser. By default Cookie Pal only 
intercepts cookies from the major web browsers and some other software.
So what can you do about it? You can get Cookie Pal to monitor these other programs by using the 
Add Browser command on the tray icon pop-up menu. For details about how to use this command, 
click here to see the next frequently asked question .



Cookie Pal does not recognize cookies from a program that I am running.

Cookie Pal can be configured to work with most programs which can display cookie messages on your 
screen, such as news ticker programs, Internet chat programs, search programs etc.

There are two ways to configure Cookie Pal as follows:

Using the Modules option on the Configure tab in Cookie Pal
To do this, just go to the Configure tab in the main window of Cookie Pal and click on the Modules 
button. You can then click the Add button to add a new program that Cookie Pal should watch for 
cookies. You need to enter the actual name of the .EXE file that is used to run the program as well as a
description. You can click the Help button for more information.

Using the Add Browser command
You can use the Add Browser command in Cookie Pal as follows: 

1. Make sure that Cookie Pal is running. You will see the little cookie icon in the taskbar tray (next 
to the clock in the lower right corner of the screen) when it is running. 

2. Wait until you see one of the cookie messages on screen from the program in question. 

3. While the cookie message is still displayed, click on the Cookie Pal icon in the taskbar tray with 
the *right* mouse button. A popup menu will appear, and you will then need to select the "Add 
Browser" command. 

4. Cookie Pal will attempt to find any cookie alerts which are on screen and will try to identify the 
program which displayed the alert. If the program which displayed the alert is a 16-bit program, 
then Cookie Pal will report that it cannot find any cookie alerts on the screen. 

5. If Cookie Pal does recognize the alert, it will display a message saying that it has detected the 
program which displayed the alert, and will ask you if you would like to monitor this program in 
the future. Click Yes to add this program to the list of programs monitored by Cookie Pal. 

6. You will then need to restart both Cookie Pal and the other program, before Cookie Pal will work
correctly with it. 

For more information about the Add Browser command, click here .



When I delete cookies, they keep coming back.

This will usually happen with Netscape and Opera browsers. If this happens then make sure that your 
web browser is not running when you try to delete the cookie. Netscape and Opera both keep a copy 
of the cookie file in memory while it is running and writes a new file to disk based on what it currently 
has in memory at various times while it is running and when it is shut down. Therefore if you delete a 
cookie in Cookie Pal and then close down Netscape, the cookie file will later be overwritten and the 
cookie will reappear. As stated earlier, to make sure that cookies are correctly deleted, close down your
web browser before deleting the cookies in Cookie Pal. 

 



Why is the Session page blank when I know I have received cookies?

The Session tab displays cookies which have been received for the current session only. Every time 
Cookie Pal exits it clears all entries from this tab, so if you start Cookie Pal and immediately look on the
Session tab it will always be empty. You should examine the Session tab after you have been web 
browsing and have received cookies, but before you close your web browser. The "Always Accept" and
"Always Reject" buttons will only be enabled when you click on one of the entries in the list on the 
Session tab to highlight the entry.



Why don't cookies which I have received show up on the Cookies page?

Not all cookies that are received are stored permanently on your hard disk. Some cookies are stored 
only in memory and are discarded when your browser shuts down. These are known as temporary 
cookies and either have no expiration date, or their expiration date will be set to End of Session.

Also, it is possible that Cookie Pal is not looking in the correct place on your disk for any existing 
cookies (although Cookie Pal should correctly determine the location of your cookies automatically). If 
you are using Internet Explorer, cookies are stored in your Windows\Cookies directory, or in your 
Windows\Profiles\<UserName>\Cookies directory, depending on whether or not you have user profiles 
set up on your machine. Each cookie is stored in a separate file with a name ending in .TXT. If you are 
using Netscape, all cookies are stored in a single file named cookies.txt. You can use the windows 
"Find files or folders" feature to search for cookies.txt to find where it is located on your system. 

You can verify the location where Cookie Pal is looking for your permanent cookies by displaying the 
main window of Cookie Pal and clicking on the Cookies tab. The folder in which Cookie Pal looks for 
cookies is displayed at the bottom of the window. 
If you find that Cookie Pal is not looking in the right place, you can tell Cookie Pal to explicitly look for 
cookies in a particular directory by clicking the Change button on the Cookies tab and selecting the 
correct directory.



How do I configure Cookie Pal to work with my non-English version of Internet 
Explorer or Netscape Navigator?

Cookie Pal has built in support for the following languages:

· English 
· Dutch 
· French 
· German 
· Italian 
· Spanish 
· Swedish 

If you are using a web browser configured for one of the above languages then you can easily get 
Cookie Pal to work with it as follows: 

1. Double click on the cookie icon in the taskbar tray (next to the clock in the lower right corner of 
the screen) to display the main Window of Cookie Pal. 

2. Click on the Configure tab. 
3. Click on the "Browser Settings" button.
4. In either the Internet Explorer or Netscape section of this window, click on the Defaults button 

and then select the desired language. 

Cookie Pal will then automatically enter the correct settings for that language version of Internet 
Explorer or Netscape.

If you need to support a browser from a language other than the ones listed above then you will need 
to do a little more work. 

First you will need to note the *title* of the window which appears when you receive a cookie. You will 
need to enter this text (exactly the same including upper/lower case) into the "Cookie window title" field
on the Configure tab in Cookie Pal.

Next you will need to note the text which appears immediately before the expiration date which is 
displayed on the cookie alert window. You will need to enter this text into the "Expiration date text" field 
on the Configure tab in Cookie Pal.

Next, make sure that the word which appears in the "Cookie text" field in Cookie Pal appears 
somewhere on the cookie alert window.

Once you have done all of this, Cookie Pal should recognize the cookie alerts from your browser.



What is the CPBRWTCH.EXE program?
The CPBRWTCH.EXE program is used to enable the auto-start feature of Cookie Pal. If you set the 
Startup Method (on the Configure tab) to Start with browser then the CPBRWTCH.EXE program will be
used to monitor when your web browser starts so that Cookie Pal can be loaded when needed. An 
entry is added to the registry, under the HKLM\Software\Microsoft\Windows\CurrentVersion\Run key so
that CPBRWTCH.EXE will be loaded each time you start Windows. This program runs in the 
background and consumes very little resources or processor time. If you select the Start manually or 
Start with Windows Startup Method then the Registry entry is removed and the CPBRWTCH.EXE 
program will be closed.



When I run my web browser without Cookie Pal I now see annoying dialog boxes 
asking about Cookies.

Cookie Pal relies on the warnings which your browser normally displays when a cookie is received. 
These warning settings are turned on by default when Cookie Pal is installed and whenever a web 
browser is started while Cookie Pal is running. If Cookie Pal is running it will intercept the warning 
messages for you, but if you run your web browser without Cookie Pal you may want to turn off these 
warnings. Be aware that by doing this, your web browser will automatically accept all cookies which it 
receives.

To change the warning settings of your browser, see the Browser Options help topic.

 



How do I turn off the sound which gets played when Cookie Pal encounters a 
cookie?

If you have a sound card installed in your system you may want to select this option. Normally when 
Netscape Navigator or Internet Explorer display a cookie alert message you will hear a sound as the 
message box is displayed. When Cookie Pal intercepts the message box it cannot prevent the sound 
from being played at that time.

To disable the sound permanently follow these steps:

1. If the main Cookie Pal window is already displayed, then go to step 4.
2. Right click on the Cookie Pal icon in the taskbar tray.
3. Select Show from the menu which appears to display the main Cookie Pal window.
4. Click on the "Sounds" tab with the left mouse button.
5. Click on "Disable standard alert sound" so that a check is displayed next to the option.

Selecting this option will cause Cookie Pal to permanently disable the sound while both Cookie Pal and
a web browser are running . The side effect of this is that it will disable the sound for all similar 
message boxes displayed by any other applications in your system. The sound is only disabled while 
Cookie Pal and a browser are running if this option is checked. When you close your browser or 
Cookie Pal the sound setting will be restored in the registry.

You can also select alternate sounds to be played when cookies are accepted or rejected on the 
Sounds tab of the Cookie Pal window, if you like.



Adding a new filter
The New Filter window allows you to add the name of a web site from which you wish to accept or 
reject cookies unconditionally. You can type the domain name or IP address of the web site into the edit
box, and click OK to add it to your accept or reject lists.

You can enter a domain name such as www.abc.com, or an IP address such as 200.200.200.200.

Using wildcards
You can use wildcards (the asterisk (*) character) in the web site name, or IP address. 

When entering a server name, the wildcard must be the first character entered, and there can only be 
two additional parts to the server name (separated by dots). For example you can enter *.abc.com, but 
not *.abc.def.com or www.abc.*.

When entering an IP address, the wildcard must be the last character, replacing the last number in the 
address. For example 200.200.200.* is OK, but *.200.200.200 is not.

Using a wildcard in a filter will cause a group of web sites to match the filter. For example the filter 
*.abc.com will match www.abc.com, www2.abc.com and www.info.abc.com.

For more information on using wildcards and filters see the Filters help topic.



The KBORDERS.EXE program cannot be found. To view the order form in this help file, click here.



Internet Explorer cookies that appear grayed
When viewing cookies for Internet Explorer some cookies may appear grayed. These cookies are 
stored on your system but are not recognized by Internet Explorer, and hence are orphaned cookies. 
This can occur if the disk file containing the cookie data has been deleted but the index entry that is 
maintained by Internet Explorer still exists. It can also occur if the index entry for the cookie has been 
deleted but the disk file still exists. In both of these cases Internet Explorer will not send any of this 
cookie data to a web server, but you may want to delete these cookies to free up disk space and tidy 
your system.



Changing the browser settings

The Browser Settings window allows you to define the text which Cookie Pal uses to recognize cookie 
alerts displayed by your browser. This is set up by default for English language versions of these 
browsers, but may be different for other languages. 

Internet Explorer

Cookie window title
Enter the text which appears in the title bar (or caption) of the message box which is displayed 
by Internet Explorer when a cookie has been received. This text must match exactly (including 
case) the text used in the title bar.

Or
You can enter an alternate window title here if the web browser can display cookie messages 
with a different title than the one entered above.

Third-party text
This option applies only when using Internet Explorer with the Advanced Security Privacy 
Update installed. If used, it should contain some text that appears in the cookie message box 
displayed by Internet Explorer when a third-party cookie is received. For more information about
third-party cookies see the Reject third-party cookies help topic. 

Expiration date text
When Internet Explorer displays a cookie alert, it displays the expiration date of the cookie if it 
has one. In the English language version this is displayed directly after the text "It expires on", 
as in "It expires on Mon Dec 01 1997 GMT". You must enter here the unique text which appears 
immediately before the expiration date in the cookie alert dialog which is displayed by Internet 
Explorer when a cookie is received. For Internet Explorer 4.0 just accept the default value for 
this setting as IE4 displays the expiration date in its own field and this setting is not required. 

Cookie text
You must enter the word "cookie" as displayed by Internet Explorer in each of their cookie alert 
dialog boxes. If Cookie Pal does not find this word contained in the text of the alert dialog box 
then it will not intercept the dialog box and it will be displayed as normal.

Defaults
This button will reset all of the text options for Internet Explorer to their default values for a user 
selectable language. When you click this button a menu will appear allowing you to choose a 
language. You should choose the language used by your copy of Internet Explorer and the 
default values for that language will be put into the above fields. If you select this option you will 
lose any overrides you may have entered and will have to enter them again.

Netscape

Cookie window title
Enter the text which appears in the title bar (or caption) of the message box which is displayed 
by Netscape Navigator when a cookie has been received. This text must match exactly 



(including case) the text used in the title bar.

Expiration date text
When Navigator displays a cookie alert, it displays the expiration date of the cookie if it has one.
In the English language version this is displayed directly after the text "persist until", as in "This 
cookie will persist until Mon Dec 01 1997 GMT". You must enter here the unique text which 
appears immediately before the expiration date in the cookie alert dialog which is displayed by 
Netscape Navigator when a cookie is received.

Cookie text
You must enter the word "cookie" as displayed by Netscape Navigator in its cookie alert dialog 
boxes. If Cookie Pal does not find this word contained in the text of the alert dialog box then it 
will not intercept the dialog box and it will be displayed as normal.

Defaults
This button will reset all of the text options for Netscape to their default values for a user 
selectable language. When you click this button a menu will appear allowing you to choose a 
language. You should choose the language used by your copy of Internet Explorer and the 
default values for that language will be put into the above fields. If you select this option you will 
lose any overrides you may have entered and will have to enter them again.



Changing the programs that are monitored for cookies

The Monitored Modules window lets you change the programs that Cookie Pal monitors for cookies. 

The list displays all of the programs that Cookie Pal knows about. There are many programs that are 
provided with Cookie Pal by default. You can click the check box next to any of these programs to 
change whether Cookie Pal will monitor that program or not. The first programs (Internet Explorer and 
Netscape) are always monitored and cannot be changed.

You can use the New button to add a new program that Cookie Pal should monitor. When you click this
button you will be prompted to enter a description, the module name, and the type of cookie messages 
that the module displays (this will normally be Internet Explorer style warnings). You should also see 
the Add Browser command for another way to add programs to this list.

You can use the Edit button to change the properties of any of the programs. You can only edit 
programs that you have added yourself using the New button. You cannot edit programs that were 
supplied built-in to Cookie Pal.

You can use the Delete button to delete a program from the list completely. You can only delete 
programs that you have added yourself using the New button. You cannot delete programs that were 
supplied built-in to Cookie Pal.

The Reset button will restore the default list of programs that Cookie Pal monitors for cookies. This 
may be needed if the list of programs becomes damaged somehow. When you click the Reset button, 
any programs that you have added yourself will be removed, and the default list of programs will be 
restored.



Module Properties
The module properties window allows you to add (or change) the details of a program that Cookie Pal 
should monitor for cookies. The fields in this window are as follows:

Description
Enter a description for the program here. You can enter any text that you want to describe the program.

Name
This field must contain the name of the executable file that is used to run the program, and must not 
include the extension. For example, the program used to run Windows Media Player is named 
MPLAYER.EXE. So you would just enter MPLAYER for this program to get Cookie Pal to recognize it. 

Note: The name that you enter here must match the program name exactly or it will not work correctly. 
An easier way to add a program name precisely is to use the Add Browser command which allows 
Cookie Pal to automatically detect the name of the program that is displaying a cookie message on 
screen.

Type
You must select the type of cookie warnings that the program displays when a cookie is received. You 
can choose from Internet Explorer, Netscape or Opera style cookie warnings. Most programs display 
Internet Explorer style cookie messages and so that option is the default setting.




